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Installation of Power! Free Trial Software

Install in Windowse XP, 2000, 98, 95, ME and NT
1) Close any open software programs. If downloaded from www.jaffesoftware.com, double click the
PowerSetup.exe file on your hard drive, or insert the Power!™ CD ROM into your drive. Wait for the
installation window to appear, or if the installation window does not appear:

a) Click the Windows Start button, then click Settings, then click Control Panel.

b) Double click on the Add/Remove Programs icon. The Add/Remove Properties appears.

c) Click the Install... button, then follow the prompts for installation of PowerSetup.exe.
2) Start Power!™ by double clicking the Power! Demo icon on your Windows™ desktop.

Password is RUN DEMO. The trial period will eventually end. Re-installing will not extend it.

Power!- Software Tutorial

This tutorial is a basic introduction to the Power! Estimator and T & M Billing™ software. This tutorial
assumes that you have a basic working knowledge of Windows applications.

Power! Estimator and T & M Billing™ includes three fully-integrated programs:
1) Power! Electrical Material Data Base™ 2) Power! Estimator™ 3) Power! T & M Billing™

Power! Electrical Material Data Base-

This is a quick tutorial of the Power! Material Data Base™ software. Press the F1 key at any time for
on-line help.

The Material Data Base stores data for electrical items. This data is used for estimating and
invoicing. You can add new items, edit existing items, change pricing by a percentage, update
pricing, print, lookup parts and more.

Let’s lookup the price for EMT conduit using the Material Lookup Explorer

1) Double click on the RACEWAYS icon in the left window pane, then double click EMT CONDUIT &
FITTINGS.

2) The EMT category of the Material Data Base is now displayed in the right window pane.

3) Click on the vertical scroll bar to look up the price for any EMT part.
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Use the Material Lookup Explorer to locate items in the Material Data Base:

¢ To resize the Material Lookup Explorer window, move the mouse pointer over the splitter bar
(between the left & right window panes) until it turns into a double arrow. Then click and hold down
the left mouse button while dragging the splitter bar to the desired position.

¢ Click on the Category tab to lookup items in a material category. Double click on a book to open a
category. Double click again to close the book. Press the Escape key to close all books. Click on the
right hand vertical scroll bar to locate items in the right window. Use mouse or arrow keys to navigate.

¢ Click on the Sub-Category tab to lookup items within the many material sub-categories. Clicking
your left mouse button on a sub-category will display the items in it. Then you can single click on the
item and it will display in the right window pane. Double click the item and a detail view of the item will
display.

¢ Click on the Items tab to look for items containing specific letters or numbers. In the Find What box,
type just a few characters of the item you are looking for. A list of all items containing the letters typed
will display. Click on an item and it will display in the right window. Double click the item and a detail
view will display.

¢ Click the Find button to search for a few letters of an item.
¢ Click the Detail View button to show the Electrical Material Data Base — Detail View.

¢ Click the Columns button to show or hide material data base columns.

Let’s find a part using computerized search.
1) Press F6 or, select Find Parts from the Materials menu. You will be presented with the following
dialog box:

Search Elacimical Matenal Data Base
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2) Select “Description” from the “Search In:” list.

3) Click in the "Find What" box, then type a few characters of the part you are searching for. Type in the
letters “hub”.

4) Click the Find Next button, or press the ENTER key. Keep clicking the Find Next button until the item
is found, then click Close button. If a match is made the item will display in the Data Base window. Try
different characters if needed.

5) To begin a new search, repeat the above steps.

Let’s enter a new price for an existing material.
1) Click on a price in the Cost column of the Electrical Material Data Base window.
2) Type in a new price (numbers only), then press the Enter key. It's that simple!



Let’s enter a new part.
1) Double click on any part in the Electrical Material Data Base window (window on the right). The
Electrical Material Data Base - Detail View will display.
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2) Click the Add button, then either select a category to add the new part into, or press the Escape key
to display the next blank row in the Material Data Base.

3) Type in a Material Description for the new part, then press the Enter key.

4) Type in the Wholesale Cost (contractor price), then press the Enter key.

5) Press the Enter key to bypass the calculated Retail Price (resale price), or type in any retail price
you want.

6) Press the Enter key to bypass the Column 3 Price (manufacturers suggested price) or, type in the
column 3 price.

7) Press the Enter key to bypass the Discount Factor percentage, or type in a discount factor.
(Discount Factor percentage X Column 3 Price = Wholesale Cost).

8) Type in a Labor Hour Unit (decimal portion of an hour to install the part). Press the Enter key.

9) Press the Enter key to bypass the UPC Number (uniform product code), or type in an 11 digit UPC
number.

10) Press the Enter key to bypass Custom Field 1, 2 or 3, or enter letters or numbers, if needed.
These are dummy fields, meaning they only hold information for viewing and are not used in estimating
or invoicing.

11) Optionally assign the item to a material Sub-Category by selecting from the Sub-Category list box.
To add more parts, click on Add again and repeat the process.

12) Click the Close button when done.

That concludes our quick tutorial of the Power! Electrical Material Data Base™ software. Press F1 for
on-line help.



The Power! Estimator-

This is a quick tutorial of the Power! Estimator™ software. For more detailed instruction press the F1 key
for on-line help.

First, let’s make a new estimate

1) Select New from the File menu, then select and click Estimate. A new untitled estimate window
appears with the Work Order / Job Information window displayed. This window is used for creating work
orders and recording job information.

The Power! Estimator™ sections are arranged in windows accessed by clicking the corresponding tab.
To scroll through all the tabs, click the arrow icon in the upper left hand corner of the estimate window.

The estimate window represents one estimate (though you may have many estimates open at once).
Each tab displays an estimate section. All sections are automatically added into the selling price
displayed in the Bid Summary section.

Use these different estimating sections combined or separately, according to your preferences or
estimate requirements.

¢ Use the Unit Bid section for listing miscellaneous materials and labor.

¢ Select assemblies for instant wire & conduit, feeder, receptacles, switches & fixtures, and main
service. Create your own assemblies using our Custom Assembly section.

¢ The Premise Wiring section is well suited for entering the entire take-off from electrical plans for
devices, fixtures, and dedicated circuits for homes, stores and offices.

¢ Use the Quotes section for quotes from vendors, sub-contractors, trenching, etc.
¢ Three condensed parts list are built, Parts List, Purchase Order and Quote Request.
¢ The Bid Summary allows you to adjust the selling price, labor, profits, direct costs, etc.

For purposes of this tutorial we are going to jump right into assembly estimating.

The quickest way to estimate is using our built-in assembly templates. Assemblies are groups of
electrical parts. They can be saved as individual files to your hard drive. These files can be opened into
different estimates having similar material and labor requirements. You may create and save an unlimited

number of assemblies with Power!™,

Unique to our estimating system are six fully adjustable assembly templates which greatly facilitate the
creation of electrical material groups.

¢ The Wire & Conduit assembly quickly creates conduit, fittings, and wire combinations.

¢ The Feeder assembly automatically sizes your conduit for feeders with optional grounding conductor,
circuit breaker and equipment.



+ The Receptacle assembly quickly creates receptacle outlets, branch and home run. It automatically
generates materials and labor based on a small amount of input. For example; entering a receptacle
quantity will generate the proper quantity and type of boxes, plates, wire nuts, cable, conduit, wire
and fittings!

¢ The Switch & Fixture assembly quickly creates switch and fixture outlets, branch and home run. It
also automatically generates materials and labor.

¢ The Main Service assembly sizes your conduit and wire for 3 wire single phase or 4 wire three phase
electric services.

¢ The Custom Assembly allows you to build any assembly with up to 49 parts each. Use it for adding
any needed material or labor into an estimate. This assembly template works very well for multi-
phase projects.

Let’s create a Wire & Conduit assembly

1) Click on the Wire & Conduit tab at the top of the window to display the assembly window.

2) Click on the Options button. Wire & Conduit Options is now displayed.

3) Select options for wire & conduit assembly, then click the Create Assembly button. The parts

displayed can easily be deleted, changed or added.
4) Type in an assembly description. Condust Arsembly

5) Enter a percentage in the Adjust Hrs box to F:'.".fcrrr ) [51'“’,’“_ 7 hj:?“‘ F"'""’“
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Repeat the above process for Feeder Assembly,
Receptacle Assembly, Switch & Fixture Assembly, Main Service Assembly and Custom Assembly.

The most basic method of estimating is called the Unit Bid. This is the process of adding items into an
estimate list.

Let’s add some parts to the Unit Bid
1) Click on the Unit Bid tab at the top of the estimate window to display the Unit Bid section.

[

UNIT BID JOB PHASE: Miscellaneous

ADUUST COST: 100 ADJUST HRS: 'i

JOB PHASE | yoTAL EXCOST: 8 230 TOTAL EXHRS: 4
ID¥ [DESCRIPTION OTY | COST | EXCOST HRS| EXHAS
Ig b |2P-100A 240 Fused Swelch nemaE R 1 | §1.2004 1200 0 7L 07

233 11554 Load Cobr 3P MLO Nemal 12024 1] $113.42 113 070 0.7
||




2) Right click on a blank row below the Description or ID# heading in the estimate window. The Material
Data Base pop-up menu will display. Click on a material category from the Material Data Base pop-up
menu. The Select Items window will display. To use the Select Items window, follow these instructions:
a) A list of materials for the category selected is already displayed. Find items by scrolling the list, or
type a few characters of the item in the “Find What” box. Click the Find Next button to display items
that contain your search characters.
b) Narrow your choices by selecting a sub-category that is within a material category. Click the Sub-
Category List to select a sub-category. A list of materials for the sub-category will display. Click the
Category tab to select from a different material category.
c) Click on the Items tab to look for items containing specific letters or numbers. In the Search Entire
Data Base For: box, type a few characters of the item you are looking for. A list of all items containing
the characters typed will display.
d) Click on the items needed, then click the OK button.

Alternate Method:

1) From the Window menu click Tile Horizontal. The windows are now arranged horizontally.

2) Right click in the Electrical Material Data Base window. The Material Data Base pop-up menu will
display.

3) Click on a material category from the Material Data Base pop-up menu.

4) Click on the vertical scroll bar until you see the part needed. Click on the part.

3) Click on the Estimator window to make it active, then double click on a blank row under the ID# or
DESCRIPTION column heading. The part selected in the Material Data Base is now in your estimate.
Repeat to add all the parts you need.

Want to lock-in prices with your vendor?

Let’s create a Quote Request

1) In the estimate window, click the Reports button, then click on Quote Request.

2) Click the “OK” button when prompted. The Quote Request window will be displayed with a list of all the
estimated materials to be quoted for the job. Print, mail or fax the form for your vendor to fill-in.

Once you have the job you will want a Parts List.

Let’s create a Parts List

1) In the estimate window, click the Reports button, then click on Parts List.

2) Click the “OK” button when prompted. The Parts List window will display with a list of all the estimated

materials.

The Bid Summary is where final adjustments are made that will win you the bid!

Let’s view the Summary window
Click on the Summary tab to display the Bid
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Let’s adjust the selling price in the Summary window

1) Use the scroll bars to display job charges, job profits, labor breakdown, direct costs and assembly
totals.

2) Select an input box to change by clicking on it with the mouse.

3) Type in a new number, then press the Enter key.

The real beauty of Power!™ becomes apparent when you adjust any number and a new selling price is
calculated instantly.

Want to create a summary based on a job phase?

Let’s create a Job Phase Summary

1) Click the Reports button, then click on Job Phase Summary. The “Create A New Job Phase
Summary?” window will display. Click the OK button. The “Select Job Phases To Include In Report”
window will display.

2) Make sure the job phases you want to include in the report are listed on the right. Add or remove job
phases as needed.

3) Click the OK button. The report will display. Click the scroll bar to view the entire report.

The final step in preparing a bid for your prospective customer is completing the Proposal/Contract form.
Let’s create a new Proposal/Contract.

1) In the Estimate window, click on the Proposal button, or from the File menu, select New, then select
Proposal. Then select and click Unlimited Pages. A new untitled Proposal/Contract window will appear.
2) For detailed instruction in creating, saving and opening Proposal/Contracts press F1 for on-line help.
3) Select Close from the File menu to close the Proposal/Contract window.

That concludes our quick tutorial of the Power!™ Estimator software. For more instruction press F1.

Power! T & M Billing-

This is a quick tutorial of the Power! T & M Billing™ software. For more detailed instructions press F1 for
on-line help.

Power! T & M Billing™ consists of three fully integrated software programs: Invoicing, Accounts
Receivable and Customer/Vendor Data Base.

Let’s customize the invoice window.

Before making your first invoice, customize the invoice window to fit your company needs. This way
information is entered only once and will be automatically displayed on every invoice you make. To
customize the invoice window:

1) Select Customize from the File menu, then select Invoice, then click on one of the seven invoice
styles.

2) Click with the mouse on the words “YOUR ELECTRIC COMPANY” at the top of the invoice window.
Type in your company name, then press the Enter key twice. Repeat this process for address and
telephone number.

3) Click the Options button at the top of the window, then click Sales Tax Usage. The invoice options
dialog will display.
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4) Select options for invoices by clicking with the mouse, then either select an option or type in a new
value. Click the Invoice button when done to return to the invoice.

5) Select Close from the File menu. You will be prompted to save your changes. Click Yes to save
changes or click No to close without saving changes.

Let’s make a new Invoice

1) Select New from the File menu, then select Invoice, then click on an invoice style. A new invoice
window will display.
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Lets open the Customer/Vendor Data Base
1) Click the Customer button (top left of the invoice window).

Lets add a new customer into the Customer/Vendor Data Base
1) The Customer/Vendor Data Base - Detail View is displayed.
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2) Click the Add button for a new record. Fill in the data by typing information, then press the Enter key
to move to the next field. Click the Close button when done.

Lets place customer information into the invoice

1) Click on the invoice window to make it active, then double click again on the words “Double Click Here
To Transfer Customer Data ...”. A customer list will appear.

2) With the mouse, click on any customer. The selected customer will now appear in the invoice. To edit
the customer information in the invoice, select, then press the F2 key.

Use of a double window envelope eliminates the need to address and return address envelopes. (Deluxe
#091564 Double Window Envelope 8 5/8"X 3 5/8" 800-328-0304)

Lets fill-in job notes for the invoice
1) Click on the job notes area (below the customer address) to display a text dialog box. Type in any
notes about the job. Click OK when done.

Lets fill-in the material section of the invoice
The material section (below job notes) can be used to itemize parts or, you can type in flat rates.
Anything can be typed into the material section of the invoice.

To copy parts from the Electrical Material Data Base to the invoice:
2) Right click on a blank row below the Description or ID# heading in the estimate window. The Material
Data Base pop-up menu will display. Click on a material category from the Material Data Base pop-up
menu. The Select Items window will display. To use the Select Items window, follow these instructions:
a) A list of materials for the category selected is already displayed. Find items by scrolling the list, or
type a few characters of the item in the “Find What” box. Click the Find Next button to display items
that contain your search characters.
b) Narrow your choices by selecting a sub-category that is within a material category. Click the Sub-
Category List to select a sub-category. A list of materials for the sub-category will display. Click the
Category tab to select from a different material category.
c) Click on the Items tab to look for items containing specific letters or numbers. In the Search Entire
Data Base For: box, type a few characters of the item you are looking for. A list of all items containing
the characters typed will display.
d) Click on the items needed, then click the OK button.

To type in a flat rate:

1) Use the vertical scroll bar to display the material section of the invoice (below the job notes area).

2) Click in a box under the DESCRIPTION column. Type a flat rate description then press the Enter key
twice. Type the number 1 in the QTY column then press the Enter key twice. Then type the flat rate price
in the PRICE EACH column.

Lets fill-in the labor section of the invoice

Press the END key (or use the vertical scroll bar) to move to the first line of the Invoice Labor Charges
area (bottom of the invoice page). Fill-in labor charges using either of two methods:

Select Labor From List: Click the right mouse button on a line in the labor section, then select an
employee from the Labor / Employees list. Employees can be set-up in the Electrical Material Data Base
under the Custom Category named Labor / Employees.

Type In Labor Information: Click in a box under the DATE column. Type a date (format is: 01/01/09),
then press the Enter key twice. Repeat this process for DESCRIPTION, HOURS and HOURLY RATE
(by the way, column headings can be changed by simply typing over them).



When you are done making your invoice, close it out so that it is recorded in the Accounts Receivable
and saved to a file for future use.

Let’s Close-Out our invoice.

1) Click on the invoice window to make it active.

2) Click the Close-Out button from the top of the Invoice window, then click the Yes button. All prices on
the invoice will be locked. This insures that as prices change in the Material Data Base that the invoice
will retain the prices as invoiced. Locked prices can be unlocked by using the DeOverWrite feature. To
unlock an item, click on it, then press the F5 key. The red item (locked) will turn blue (unlocked).

3) You will be prompted with the Save As dialog box. Select a folder to save the invoice in and type a
name for the invoice. Click the Save button when ready.

4) Invoice information will be automatically posted to the Accounts Receivable. The Accounts Receivable
window is now displayed.

Let’s look at the Accounts Receivable window.

The Accounts Receivable records key invoice information including; invoice number, date, terms,
customer name, invoice amount, export status, sales tax, sales tax percentage, materials and labor,
other and job name.

# Accounts Receivable

&dd.—'Edill Find | Sort | Delete Reportz | Statements Save
4

k| Receivables AR Ading
INVOICE# | DATE |TERMS| CUSTID | CUSTOMERHNAME | AMOUNT | RECEIVED | BALANCE | EXPORT | SALESTAX |
TOTALS: $13.500.00  $8,000.00  $5,500.00 $294.00
3355 | 070212000 30 PAYS3 Big Bucks Incorporated $9,90000 | $5000.00  $4,90000 *Exported® $210.00
3356 | 030212000 30 POTI4 Pays On Time Incorporated | $1,20000 | $1,00000 | $20000 *Unexported: $35.00
3357 | 03M9/2000 30 B Electrical iwholesale Store | $2,400.00 | $2,00000 | $400.00 *Unexported: $4000 | o
| LIJ

The total invoice sales AMOUNT, total money RECEIVED and total BALANCE is displayed at the top of
the Accounts Receivable list. As payments are received from customers, enter the amount paid in the
received column. Total sales tax, total materials and total labor are also displayed. To display additional
fields click the horizontal scroll bar on the hand right arrow.

Double click on any record in the window. The Accounts Receivable - Detail View will appear. This dialog
is used to add, edit, find or delete Accounts Receivable records. Click the Close button.

The Accounts Receivable can be used to add external invoice records, edit existing records, sort, print,
search and delete invoice records.

In addition to the features we have explored in this short tutorial, the Power!™ T&M Billing software
includes features for creating accounts receivable reports and statements. Reports can be automatically
created for customers, jobs, sales tax payable, material & labor and an excellent invoice aging report.
Statements can be automatically created to help you get paid. Play with these features by clicking the
Reports and Statements button at the top of the Accounts Receivable window.

That concludes our tutorial of the Power!™ T&M Billing software. For detailed instruction press F1 for on-
line help.





